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BAB IV.  

APLIKASI PROGRAM ANIMASI  

(MACROMEDIA FLASH
®
)  

 

A. Pendahuluan  

Salah satu perkembangan mutakhir teknologi komputer yang berpengaruh 

besar terhadap aplikasi komputer adalah munculnya perangkat lunak untuk membuat 

animasi. Program aplikasi yang amat populer adalah Macromedia Flash
®

. Aplikasi 

perangkat lunak untuk membuat animasi pada awalnya dikembangkan oleh 

perusahaan pembuat film animasi Amerika dan penggunaannya masih pada kalangan 

terbatas. Namun, perkembangan software animasi saat ini begitu pesat dan 

penggunaannya tidak lagi terbatas oleh perusahaan film, melainkan telah meluas ke 

masyarakat awam.  

Macromedia Flash
®

 sebagai salah satu program animasi memberi kemudahan 

bagi penggunanya untuk dapat berkreasi membuat media animasi yang kompleks 

dengan cara atau langkah-langkah yang mudah diikuti. Berikut ini panduan aplikasi 

Macromedia Flash
®

.  

 

B. Mengenal Toolbox  

Toolbox, dalam Macromedia Flash
®

, berfungsi untuk menyimpan berbagai 

peralatan standar yang digunakan dalam membentuk atau memanipulasi bentuk-

bentuk yang dibuat. Terdapat berbagai Tool yang dapat kita pilih beserta fungsinya 

yang berbeda-beda. Toolbox dalam Flash terbagi menjadi 4 bagian, yaitu:  



 27 

 

Gambar 6. Bagian Toolbox dalam Mc. Flash.  

 

 

1) Tools 

Bagian ini berisi alat-alat (tool) yang berguna untuk membentuk dan merubah 

tampilan dari berbagai macam objek.  

(a) Selection Tool  

Tool ini berguna untuk menyeleksi objek atau merubah bentuk sebuah objek. 

Anda dapat memilihnya dengan memilihnya pada icon dalam Toolbox atau 

dengan menekan shortcut key V pada keyboard.  

(b) Sub-selection Tool  

Tool ini berguna untuk merubah bentuk sebuah objek pada titik atau nodenya. 

Anda dapat memilihnya dengan memilihnya pada icon dalam Toolbox atau 

dengan menekan shortcut key A pada keyboard.  

(c) Line Tool  

Tool ini berguna membuat bentuk garis. Anda dapat memilihnya dengan 

memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key N pada 

keyboard.  
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(d) Lasso Tool  

Tool ini berguna untuk memotong objek. Anda dapat memilihnya dengan 

memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key L pada 

keyboard.  

(e) Pen Tool  

Tool ini berguna untuk membuat bentuk objek dalam titik atau node. Anda dapat 

memilihnya dengan memilihnya pada icon dalam Toolbox atau dengan menekan 

shortcut key P pada keyboard.  

(f) Text Tool  

Tool ini berguna untuk membuat teks. Anda dapat memilihnya dengan 

memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key T pada 

keyboard.  

(g) Oval Tool  

Tool ini berguna untuk membuat bentuk oval atau lingkaran. Anda dapat 

memilihnya dengan memilihnya pada icon dalam Toolbox atau dengan menekan 

shortcut key O pada keyboard.  

(h) Rectangle Tool  dan Polystar Tool  

Tool ini berada pada satu tempat, dan anda dapa memilih dalah satunya dengan 

klik tahan pada tool. Tool ini berguna untuk membuat bentuk persegi / kotak 

(rectangle) dan segilima (polistar). Anda dapat memilihnya dengan memilihnya 

pada icon dalam Toolbox atau dengan menekan shortcut key R pada keyboard 

untuk memilih Rectangle Tool.  

(i) Pencil Tool  

Tool ini berguna untuk membuat bentuk yang anda sukai, namun berbasis garis. 

Anda dapat memilihnya dengan memilihnya pada icon dalam Toolbox atau 

dengan menekan shortcut key Y pada keyboard.  

(j) Brush Tool  

Tool ini berguna untuk membuat bentuk objek yang berbasis brush. Anda dapat 

memilihnya dengan memilihnya pada icon dalam Toolbox atau dengan menekan 

shortcut key B pada keyboard.  
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(k) Free Transform Tool  

Tool ini berguna untuk merubah/transformasi bentuk berupa ukuran, rotasi, 

maupun skew. Anda dapat memilihnya dengan memilihnya pada icon dalam 

Toolbox atau dengan menekan shortcut key Q pada keyboard. 

(l) Fill Transform Tool  

Tool ini berguna untuk merubah warna gradasi. Anda dapat memilihnya dengan 

memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key F pada 

keyboard. 

(m) Ink Bottle  

Tool ini berguna untuk mewarnai garis tepi objek / stroke. Anda dapat 

memilihnya dengan memilihnya pada icon dalam Toolbox atau dengan menekan 

shortcut key S pada keyboard.  

(n) Paint Bucket Tool  

Tool ini berguna untuk mewarnai objek / fill. Anda dapat memilihnya dengan 

memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key K pada 

keyboard. 

(o) Eyedropper Tool  

Tool ini berguna untuk menduplikat warna. Anda dapat memilihnya dengan 

memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key I pada 

keyboard. 

(p) Eraser Tool  

Tool ini berguna untuk menghapus objek. Anda dapat memilihnya dengan 

memilihnya pada icon dalam Toolbox atau dengan menekan shortcut key E pada 

keyboard.  

 

Kita dapat membuat bentuk grafis (kotak atau persegi) menggunakan tools 

dengan berbagai warna maupun style. Untuk membuatnya, misal bentuk kotak, ikuti 

langkah-langkah berikut:  

1. Klik Rectangle tools  pada toolbar  

2. Klik drag pada halaman kerja membentuk kotak  

3. Sesuaikan dengan ukuran yang diinginkan  
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4. Menggunakan Arrow tools , klik pada gambar.  

5. pada fill color pilih warna yang anda sukai.  

 

Cara ini sama halnya jika kita ingin menggunakan Ovale Tools , Pencil 

Tools , dan lainnya.  

 

2) View  

Dalam bagian ini berisikan tool untuk merubah tampilan atau display 

dokumen, dimana sangat berguna jika anda ingin memperbesar atau memperkecil 

tampilan layer untuk melihat detail dari sebuah objek.  

 

(a) Hand Tool  

Tool ini berguna untuk menggeser layer seperti halnya tangan. Anda dapat 

memilihnya dengan memilihnya pada icon dalam Toolbox bagian view atau 

dengan menekan shortcut key H pada keyboard.  

(b) Zoom Tool  

Tool ini berguna untuk memperbesar atau memperkecil layer seperti halnya lup. 

Anda dapat memilihnya dengan memilihnya pada icon dalam Toolbox bagian 

view atau dengan menekan shortcut key M atau Z pada keyboard. 

 

3) Colors  

Dalam bagian Color ini berisikan tool untuk merubah warna dari objek dabik 

itu berupa warna stroke maupun fill.  

(a) Stroke Color Tool  

Stroke Color berguna untuk mewarnai bentuk stroke atau garis luar dari objek.  

(b) Fill Color Tool  

Fill Color berguna untuk mewarnai bentuk fill atau warna dalam dari objek.  

 

4) Options  

Dalam bagian ini berisikan macam-macam option yang digunakan untuk 

melakukan modifikasi objek. Option dalam bagian ini dinamakan modifier dimana 

jenisnya bermacam-macam tergantung dari objek yang kita pilih. 
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C. Mengenal Stage  

Stage dalam Flash berguna sebagai lembar kerja untuk pembuatan berbagai 

bentuk objek yang kita inginkan. Dalam Flash MX Profesional 2004 kita dapat 

langsung membuat berbagai bentuk objek dengan memilih Tool yang kita inginkan 

kemudian membuatnya dalam Stage yang tersedia.  

 

 
Gambar 7. Bagian Stage dalam Mc. Flash  

 
 

D. Mengenal Timeline  

Timeline dalam Flash berguna untuk mengatur letak dan waktu dari animasi 

sebuah objek. Dalam Timeline ini terdapat dua bagian utama yaitu Layer dan Frame. 

 

Gambar 8. Komponen Timeline dalam Mc. Flash  
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Timeline terbagi menjadi dua bagian yaitu : 

1) Layer Dalam, berguna sebagai tempat meletakkan objek. Untuk membuat 

sebuah layer anda dapat menggunakan cara klik icon Add Layer atau 

melalui Menu Insert > Timeline > Layer 

 

Gambar 9a. Cara menggunakan layer dari menu Insert.  

 

atau dengan cara klik kanan Layer > Insert Layer 

 

Gambar 9b. Cara menggunakan layer dari bagian stage.  

 

2) Frame, berfungsi untuk mengatur waktu dari objek ataupun animasi akan 

ditampilkan. Kecepatan frame yang dimainkan sangat berpengaruh dari 

framerate yang digunakan. Makin tinggi framerate maka akan makin cepat 

pula sebuah animasi akan dimainkan. 

 

Gambar 10. Bagian Frame dalam Mc. Flash  
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Kecepatan framerate sebuah animasi dapat diatur dengan cara double click 

frame pada Timeline, kemudian memasukkan nilai framerate yang anda 

inginkan.  

 

Gambar 11. Cara mengatur framerate.  

 

E. Mengenal Library  

Library dalam Flash berguna untuk menyimpan berbagai objek maupun 

symbol yang digunakan dalam aplikasi yang dibuat. Sebuah objek yang akan dibuat 

ataupun import ke dalam Flash maka secara otomatis akan ditempatkan dalam bagian 

ini. Library dapat ditampilkan dengan memilih dari menu Window > Library atau 

dengan menekan tombol Ctrl + L dari keyboard. 

 

Gambar 12. Bagian Library dalam Mc. Flash  
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Kita dapat memasukkan objek yang terdapat dalam Library ke dalam Stage 

dengan melakukan drag langsung objek dari Library ke dalam Stage.  

 

F. Mengenal Actionscript  

Dalam Flash kita dapat membuat objek dalam aplikasi yang kita buat menjadi 

lebih interaktif. Untuk membuat interaktivitas dalam Flash kita dapat mengunakan 

perintah-perintah yang biasa disebut dengan Actionscript. Pada dasarnya actionscript 

yang kita buat hampir sama dengan bahasa pemrograman Javascript, maka jika kita 

telah terbiasa dengan bahasa pemrograman ini maka ini akan sangat membantu 

dalam membuat aplikasi menggunakan actionscript. Dalam actionscript kita harus 

memahami tiga macam komponen untuk membuat aplikasi menjadi lebih interaktif, 

yaitu :  

1) Event adalah peristiwa yang terjadi untuk memicu sebuah aksi pada objek  

2) Action adalah ksi atau kerja yang dikenakan atau diberikan pada suatu objek.  

3) Target  

 

Actionscript dalam Flash terdapat dalam panel Action yang dapat anda 

tampilkan dengan memilih menu Window – Development Panel – Action, atau 

dengan menekan tombol F9 pada keyboard.  

 

Gambar 13. Cara menampilkan actionscript dalam Mc. Flash.  
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Dalam Panel Action, anda dapat mengetikkan perintah langsung ke dalam 

jendela yang tersedia, atupun dengan memilih menu bantuan yang sudah disediakan 

pada panel ini. 

 
Gambar 14. Cara menggunakan menu actionscript dalam Mc. Flash  

 

G. Menampilkan Grid  

Grid digunakan untuk mempermudah pengaturan kesimetrisan halaman kerja. 

Untuk menampilkannya, pilih menu View – Grid – Show Grid atau dapat dengan 

menekan shortcut key Ctrl + ‘  

1) Menampilkan Garis, Pilih menu View – Ruller atau dapat dengan menekan 

shortcut key Ctrl + Alt + Shift + R  

2) Mengatur warna dan ukuran stage, Pilih menu Modify – Document hingga 

terlihat window Document Properties.  

 

Gambar 15. Bagian properties pengaturan kesimetrisan gambar.  

 

Dalam window document Properties tersebut anda dapat menentukan:  
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1) Property Lebar dan Tinggi lembar kerja anda dalam kolom Dimension agar 

sesuai dengan yang anda inginkan.  

2) Background Color untuk mengganti warna latar belakang sesuai dengan 

warna latar yang anda inginkan.  

3) Frame rate untuk menentukan jumlah frame yang dimainkan per detiknya 

dengan ukuran fps atau frame per second.  

4) Ruler Unit untuk mengubah ukuran sesuai dengan yang anda inginkan.  

 

H. Membuat Animasi Tweening  

Seperti yang kita ketahui dalam Flash kita dapat membuat dua metode 

animasi yaitu Animasi Tweening dan Animasi Frame by frame. Dalam hal ini 

pertama kali kita akan membuat sebuah animasi dengan metode Tweening.  

1) Animasi Motion  

Animasi motion merupakan animasi dengan mode tweening. Untuk membuat 

animasi ini, hanya menentukan titik awal dan titik akhir, selebihnya dikerjakan 

oleh computer. Buatlah file baru, pilih menu File -New Sebagai contoh dengan 

menggunakan ovale tools, buatlah lingkaran pada stage disebelah kanan. 

 
Gambar 16. Contoh membuat objek lingkaran untuk dianimasikan.  

 

Dalam Timeline, klik kanan pada keyframe 1-, pilih Create motion tween. Klik 

kanan pada frame 20 -pilih insert keyframe. 

 
Gambar 17a. Menentukan motion tween.  
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Gambar 17b. Menentukan batas keyframe.  

 

Pindahkan lingkaran ke sebelah kiri dengan Arrow Tool atau Selection Tool. 

Jalankan animasi dengan menekan Enter. Lihat preview test movie dengan 

menekan Ctrl + Enter.  

 

2) Animasi Motion Guide  

a) Buatlah file baru, pilih menu File -New 

b) Menggunakan Ovale tools, buatlah lingkaran pada stage di sebelah kanan. 

c) Klik kanan pada keyframe 1 -pilih Create motion tween 

d) Klik kanan pada frame 60 -pilih Insert keyframe 

e) Klik kanan pada layer 1 -pilih Add motion guide 

f) Akan terbentuk sebuah layer baru bernama Motion Guide 

g) Klik frame 1 pada layer Motion guide yang terbentuk kemudian dengan 

Menggunakan pencil tools, buatlah lengkungan sebagai lintasan. 

h) Klik pada frame akhir / 60 pada layer 1, pindahkan objek ke titik terakhir 

garis.  

i) Jalankan animasi dengan menekan tombol Enter atau Test Movie dengan 

menekan tombol Ctrl + Enter  
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(a)  

 

(b)  

 

(c) 
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(d)  

Gambar 18 (a-d). Teknik membuat animasi Motion Guide  

 

3) Animasi Mask  

a) Buatlah file baru, pilih menu File -New  

b) Menggunakan teks tool, buatlah tulisan dengan Text Tool. Tebalkan dan 

perbesar tulisan tersebut dari property teks di Property Inspector.  

c) Klik kanan pada keyframe 40 -pilih Insert frame  

d) Tambahkan layer baru menggunakan tombol add layer pada pojok kiri 

bawah timeline.  

e) Pilih layer baru tersebut. Menggunakan Ovale tool, buatlah lingkaran di 

sebelah kiri teks.  

f) Klik kanan pada frame 40 -pilih Insert keyframe  

g) Pindahkan lingkaran ke sebelah kanan teks.  

h) Klik kanan pada frame 1 -pilih create motion tween. Lakukan pada frame 

15  

i) Pilih layer 2 (layer paling atas) -pilih mask  

j) Jalankan animasi dengan menekan control+Enter  
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Setelah pekerjaan selesai dan ingin digunakan dan disave : 

1. Langkah berikutnya yaitu memilih type-type yang akan digunakan.  

2. Jika selesai. Klik tombol Publish-OK.  

 

 

Gambar 19. Bagian menu untuk pilihan ekstensi meyimpan file.  

 

Masih banyak lagi yang bisa digunakan dalam aplikasi ini. Anda dapat 

mencobanya dengan pilihan-pilihan yang ada didalamnya. Selamat mencoba!  

 

I. Latihan  

Buatlah tiga halaman latihan aplikasi Flash yang mewakili sebagian materi topic 

Anda, yang menunjukkan bagian (halaman) pembukaan, isi dan penutup serta 

link antar ketiganya.  

 


